
The Wizard, Merge, Splice and TVD module allows data from one or more database files to be 
manipulated in the depth domain and output to one or more destination files. Data may be depth adjusted 
and correlated, curves from multiple runs spliced together, outputs renamed etc. The module also includes 
the capability to calculate True Vertical Depth (TVD) from directional survey data and generate log data 
referenced to TVD for subsequent plotting and other operations. Most of the Merge program operations 
may be accomplished with only one pass through the data. 
Double-click the Merge icon in the Warrior group 
 



 
FIG: 11.1 Warrior Group 

  
The Wizard option is easy way to do Merge two Passes, Splice, Replace and Add curves 
11.1.1 Merge two Passes 
Double-click the Merge two Passes option. 



FIG: 11.2 Wizard/Merge two passes option.  
Set the Base Pass as Upper Pass or Lower Pass and select the Database 

FIG: 11.2 Merge two Passes set the Base Pass as Upper Pass 
Select the Input pass to merge from the Database 



FIG: 11.3 Select Input pass for Merge 
Select the Pass from the database to set as Lower Pass 

FIG: 11.4 Select Pass as Lower Pass 
Select the Pass from other Database 



FIG: 11.5 Select pass from the Database 
The software by default created a pass (Merge1). 
Set the depth to start the Merge1 (Splice the curves), Define the log interval and set the presentation. 

FIG: 11.6 Merge two passes 
Double-click the Process bar 



FIG: 11.7 Start the Process 
Processing the Merge 1 

FIG: 11.8 Processing 
Select Interactive Plot in the warrior group 

FIG: 11.9 Select Database from interactive plot 
Screen plot the Merge1 check the Merge the curves (Splice) at 200 FT. 



FIG: 11.10 Screen Plot Merge1 

11.2.2 Merge two Passes (Add Curves) 

FIG: 11.11 Select Add/Replace a curve 



FIG: 11.12 Select the Base Pass  

FIG: 11.13 Select to add curve 



FIG: 11.14 Select the curve 

FIG: 11.15 Select the curve in log Data Inputs 



FIG: 11.16 Modified input Curve 

FIG: 11.17 Add Curve and Process 

FIG: 11.18 Processing 



FIG: 11.19 Interactive Plot select pass 



FIG: 11.20 Plot the Pass 



11.2.3 Merge two Passes (Replace curve) 

FIG: 11.21 Select Curve from the database 

FIG: 11.22 Process 



 FIG: 11.23 Select the database to keep the curve 

FIG: 11.24 Plot the pass with the new curve that replaced the old ones. 

  
Double-click the Merge icon in the Warrior group. The Merge Splice TVD window will appear as shown 
below. 



FIG: 11.25 Log data Inputs  
The Merge module interface consists of six independent windows within the main Merge window. Any or all 
of the windows may be displayed at the same time.  
Note that if you loose a window by inadvertently or deliberately closing it, you can get them all back by 
clicking Window/Open All in the main menu bar.  
The main Merge menu box contains several pull down menus and selection options, which control the 
operation and set up of the Merge sub-system. The pulls down menu functions are as follows: 
 

  
11.2.1.1 Select Input Log Data.  
Selecting this option brings the Log Data Input window to the foreground. Data items e.g. curves, are 
selected from their source database(s) and dataset(s), and displayed as a scrolled list in the Log Data Input 
Window. Within the Log Data Input window several processing parameters are set. 
 
11.2.1.2 Detail Selected Inputs Selecting this option brings the Input Details window to the foreground. This window displays detailed 
information concerning the data items selected for processing. 
 
11.2.1.3 Select Output Path/File Selecting this option brings the Output Definition window to the foreground. This allows definition of the 
database and dataset to which the processed data is to be output. A default presentation, with start and 
stop depths, may be associated with the output database in this dialog also. Note that Browse buttons are 
available so that existing databases and presentation files may be easily selected. 
 

  
11.2.2.1 Enter Depth Tie Ins Selecting this option brings the Depth Correction Tie Ins window to the foreground. Processing 
parameters for data depth corrections are entered in this window.  



11.2.2.2 Enter Directional Data Selecting this option brings the Directional Survey Stations window to the foreground. Entry of directional 
survey data for TVD calculations is made in this window. 
 

  
11.2.3.1 Process Commands. Selecting this option brings the Process Control window to the foreground. Three selections may be made 
in this window. The type of processing to be performed, if the processing is to be done as a foreground or 
background task, and to the default depth units are to changed. 
 
11.2.3.2 Windows 
Conventional Windows commands for manipulating windows on the screen 

  
If the Log Data Inputs window is not active, click on Select Input Log Data ...... under the File menu. The 
Log Data Input window appears in the foreground. Clicking the Add button brings up a file selection box 
where an existing log database may be selected in the usual way. 
Once a database is selected the contents in terms of runs, passes, curves etc. are displayed as a scrolled 
list, as shown below. 
 

   

FIG: 11.26 Select Curve from the database 
Select the curves and other items, present in this list that you wish to merge. When all the required curves 
present in the current database have been selected click OK and the selected items are passed to the Log 
Data Inputs list as shown below. 



 FIG: 11.27 Log Data Inputs 
 
In the same way (Add etc.) curves and other data items may be selected from other databases until all the 
required curves are present in the Log Data Inputs window. 
From within the Log Data Inputs window, details of the processing parameters for the individual data items 
are set. The processing parameters which may be adjusted are the depth range, the name of the output 
curve and the application (or otherwise) of depth corrections.  
Select one or more curves from the input list by highlighting them in the normal way. Note that Change 
button is now activated. 
Clicking the Change button brings up the Modify Input Item dialog as shown below.  
 

  
FIG: 11.28 Modify input item 
If a group of curves was selected, the Input Dataset is shown as Multiple because several curves have 
been selected. If a single curve is selected the actual name of the curve us presented. 
The depth range of the output curve(s) may be set as desired or left as the initial range. The name of the 
output curve may be changed only if a single curve was selected. 
If depth corrections are to be applied the Apply Depth Correction box must be checked and depth 
correction tie-in points entered (see below). 
Note that currently only one set of curves may be depth corrected per pass through the data. If you wish to 
correct more than one curve (or group of curves), where one curve (or group) has different depth 
corrections than the others, then tie-in points must be entered for the first group, the merge process run and 
then the second curve (or group) selected, the second group of tie-ins entered, and a second merge 
process run. 
Detailed information on all data items in the Log Data window is present in the Input Details window. 



Select Detail Selected Inputs from the File menu. A new window is generated as shown below. A variety of 
information is shown about all the curves selected for processing. The horizontal and vertical scroll bars are 
used to access all the available information. 
 

 FIG: 11.29 Input Details 

  
Select Enter Depth Tie Ins.... bringing up the Depth Correction Tie Ins dialog as shown below. 
 

 FIG: 11.30 Depth Correction Tie Ins 
Depth tie in points may be entered from the keyboard by first clicking the Add button to obtain the window 
shown below 
 

  FIG: 11.31 Add Tie-in 



Enter the current log depth in the Measured Depth box, and the depth to which you wish to move those log 
points in the Actual Depth box. Click OK and the points appear in the scrolled list. The Add Tie-in window 
continues for entry of the next tie-in point. When all tie-in points have been entered, click Cancel. 
The log interval below the lowest tie-in point will be linearly shifted up or down, and by an amount 
corresponding to the lowest tie-in values. 
The log interval above the highest tie-in point will be linearly shifted up or down, and by an amount 
corresponding to the highest tie-in values. 
The log data between tie-in points will be linearly stretched or squeezed according to the tie-in values. 
Note that if only one tie-in point is entered then all the log data will be linearly shifted up (or down) according 
to the tie-in values. The same result may be achieved much more quickly by using the Apply Linear Shift to 
a Dataset or Apply Linear Shift to a Data Item functions in the Utilities package. 
Tie-in points mat be read from and written to a file using the Put and Get buttons. Points may be changed 
or removed using the corresponding buttons. 
Once the changes have been made to the input data, it is necessary to indicate where the merged data is 
to be written. 

  
Choose Select Output File/Path from the File menu. The dialog box shown below appears. The output 
database and dataset are typed in from the keyboard, or an existing database is selected using the Browse 
button. 
Note that it is usually quicker to select an existing dataset with the Browse button and then modify its name 
and/or dataset path, than to type in all of the fields from scratch. 
A default presentation file may be attached to the output dataset with a depth range defined in this dialog.  
The Browse button may be used to select an existing presentation file from those in the system. 
 

           

FIG: 11.32 Output definitions 
The final step in merging the data is to define the processing operation, the processing mode and the depth 
units (if other than default).  

  
Select Process Commands bringing up the Process Control Window as shown below. 
 



 FIG: 11.33 Process Control 
Select the Copy / Splice / Merge Log Data to process the data with optional depth corrections. Select Copy 
Log Data with TVD Correction to generate a new set of log data with depth referenced to TVD calculated 
from the directional survey data. Select Calculate TVD Report to generate an ASCII directional report. 
Process in Foreground causes the processing to take place in Windows foreground mode, whilst Process 
in Background allows processing to take place whilst other tasks, such as logging, are active. 

  
Select first input database as described above. Select the first section of input curve to be spliced from the 
Select Data Items window, then select the second and so on until all the original curves from which the 
spliced curve is to be assembled are present in the Log Data Inputs window. The original curves may 
originate from one or more databases.  
Select the first curve and input depth range of this curve to be used in the spliced curve e.g. 1200, 1300. 
Select the second input curve and set its range e.g. 1300, 1400. Select the third input curve. 
When all the sections have been defined go to Output Definition and define where the new curve is to 
written, as described above. Process Control, select the Copy / Merge...option and click Begin. 

  
Select Enter Directional Data. bringing up the Directional Survey Stations window as shown below. The 
depth, borehole inclination, and azimuth are entered in a manner similar to the depth tie in data. The Add, 
Change, Remove, Get, Put and Close buttons are used in the same manner as previously described for 
Depth Correction. 

 FIG: 11.34 Directional Survey Stations 



Once the data items have been selected, the destination file chosen and the processing parameters 
defined, the Processing menu or Process Control window may be selected to initiate processing of the data 
as previously described. The Window menu functions are identical to those found in any Windows application, allowing the 
individual windows e.g. Process Control, Log Data Inputs etc., to be tiled, cascaded, etc., as shown below.  

 FIG: 11.35 Process Control 
Note that the interface to the Merge program may be customized by the user in terms of window sizes and 
layout. The layout in existence at the time the program is closed will be brought back the next time the 
program is run. 
 
  


